




















































































































































































































































































DIRECTORY 

DIRECTORY 

Purpose 

Prompts 

Error Message 

DR Draw User's Guide 

The DIRECTORY function lists all files with a .PIX 
filetype on the diskette in a drive you specify. 

While you are using the EDIT function, you can look at the 
directory without affecting work in progress. 

When you PICK the DIRECTORY function, DR Draw dis­
plays the following prompt. 

Give the disk drive's identifier, a letter from A to P. As soon 
as DR Draw displays the directory, the Main Menu reap­
pears. The directory display remains on the screen until 
you do one of the following: 

• PICK the CREATE, RECALL, or OUTPUT function 
and give a valid filename 

• PICK the EDIT function to return to an active picture 
file 

• PICK the SAVE function to save an active picture file 

• PICK the DIRECTORY or EXIT function 

If you do not give a drive identifier in response to the 
DIRECTORY prompt, DR Draw returns you to the Main 
Menu. 

You can receive the following error message when you 
PICK the DIRECTORY function. 

No PIX files on diskt press DONE 

No .PIX files are on the drive specified. Press the DONE 
key to return to the Main Menu. 
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EDIT 

Purpose 

Edit Menu 

_ ChanQe 

Error Message 

EDIT 

The EDIT function lets you draw, update, and modify pic­
ture files. 

When you PICK the CREATE or RECALL function and 
give a correct filename, DR Draw automatically places you 
in the EDIT function. 

If you return to the Main Menu while editing a picture file, 
you can PICK the EDIT function to resume work on your 
active file. There are two common reasons for returning to 
the Main Menu in the middle of work~ng on a picture file: 

• You wanted to check the directory. 
• You accidentally pressed the DONE key. 

The Edit Menu replaces the Main Menu on the first menu 
line. The Edit Menu lists the seven functions shown in 
Figure 5-5. 

Select Move COPY Undelete I Delete 

Figure 5-5. Edit Menu 

You can receive the following error message when you 
PICK the EDIT function. 

No active picture filet press DONE 

You PICKed the EDIT function, but you do not have an 
active picture file. Press the DONE key to return to the 
Main Menu. 
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EXIT 

EXIT 

Purpose 

Error Message 

DR Draw User's Guide 

The EXIT function lets you leave DR Draw and return to 
the operating system. 

You can receive the following error message when. you 
PICK the EXIT function. 

Abandon active picture file? (YIN) 

You PICKed the EXIT function without saving your active 
picture file. 

If you respond Y (Yes), DR Draw abandons the active 
picture file and returns you to the operating system 
prompt. Section 4 discusses abandoning an active picture 
file. 

If you respond N (No), DR Draw returns you to the Main 
Menu. To continue working on your active picture file, 
PICK the EDIT function. To save the active file, PICK the 
SA VE function. 
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GRID 

Purpose 

GRID 

The GRID function allows you to change the appearance 
or function of the drawing grid. 

When you PICK the GRID function from the Change Sub­
menu, the Grid Submenu replaces the Change Submenu on 
the second line. If your menu cursor is a reverse video bar, 
it remains on the second menu line. If your menu cursor is 
a cross hair, it appears on the drawing surface. Section 4 
discusses menu cursors. 

Depending on the status of GRID and SNAP, three differ­
ent Grid Submenus can appear. In its initial state, the Grid 
Submenu has four functions. 

Grid I Size 2X I Size O.5X I Snap Off 

Figure 5-6a. Grid Submenu - GRID On and SNAP On 

GRID OFF 

SIZE 2X 

Message 

When you PICK the GRID function with the grid visible, 
DR Draw turns off the grid, which removes the points 
from the drawing surface. At the same time, DR Draw 
automatically turns off the snap. 

When you PICK the SIZE 2X function, DR Draw redraws 
the grid with the points twice as far apart as in the present 
grid; the grid becomes half as dense. SIZE 2X does not 
affect the size of elements in your picture file. 

You can receive the following message when you PICK the 
SIZE 2X function. 

Cannot show sridt press DONE 

Using the SIZE 2X function, you made the grid points so 
far apart that DR Draw turns the grid off and reports its 
status to you. You have not made an error; you can leave 
the grid off if you want. 
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GRID 

SIZE O.5X 

Message 

SNAP OFF 

Second Submenu 

DR Draw User's Guide 

You can make the grid more dense with the SIZE O.5X, 
ZOOM OUT, or ZOOM FULL functions. However, if you 
use one of the ZOOM functions, you must PICK the GRID 
function to make the grid visible again. 

When you PICK the SIZE O.5X function, DR Draw re­
draws the grid with the points half as far apart as in the 
present grid; the grid becomes twice as dense. SIZE O.5X 
does not affect the size of elements in your picture file. 

You can receive the following message when you PICK the 
SIZE O.5X function. 

Cannot show fridt press DONE 

Using the SIZE O.5X function, you made the grid too dense 
to be visible as individual points. DR Draw turns the grid 
off and reports its status to you. You have not made an 
error; you can leave the grid off if you want. 

You can make the grid less dense with the SIZE 2X and 
ZOOM IN functions. However, if you use the ZOOM IN 
function, you must PICK the GRID function to make the 
grid visible again. 

When you PICK the SNAP OFF function, DR Draw turns 
the grid snap off. For more details on SNAP, refer to Sec­
tion 4. 

When the snap is off, you can PICK the cursor's exact 
location on the drawing surface. The cursor does not snap 
to the nearest grid point. 

The Grid Submenu changes according to the current status 
of GRID and SNAP. 

You see the following submenu after you turn off the grid. 

Grid I Size 2X I Size O.5X I 
Figure 5-6b. Grid Submenu - GRID Off and SNAP Off 
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GRID ON 

Third Submenu 

GRID 

When you PICK the GRID function with the grid not visi­
ble, DR Draw turns the grid on and restores the points to 
the drawing surface. 

Because DR Draw automatically turned off the snap when 
you turned off the grid, no SNAP function appears on this 
submenu. You cannot turn the snap on when the grid is 
off. 

You see the following submenu when you turn the snap off 
but leave the grid on. 

Grid I Size 2X I Size O.5X Snap On 

Figure 5-6c. Grid Submenu - GRID On and SNAP Off 

SNAP ON 

When the snap is turned off, DR Draw PICKs the cursor's 
exact location on the drawing surface. The cursor does not 
snap to the nearest grid point. 

Turning off the snap is particularly useful when you are 
entering text strings inside boxes. For example, in the 
Menu Map at the beginning of this user's guide (Figure 
1-2), the menu rectangles were drawn using the LINES 
design element with the snap turned on. The text strings 
were inserted in the boxes with the snap turned off. 

When you PICK the SNAP ON function, DR Draw turns 
the snap on. 

I!ID DIGITAL RESEARCH@ --------------------------
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LAYOUT 

LAYOUT 

Purpose 

PORTRAIT 

LANDSCAPE 

SCREEN 

DR Draw User's Guide 

The LAYOUT function tells DR Draw which output for­
mat to use when you send your picture file to the screen, 
printer, or plotter. Only the part of the picture file within 
the layout appears in output. 

When you PICK the LAYOUT function from the Change 
Submenu, the Layout Submenu replaces the Change Sub­
menu on the second line. If your menu cursor is a reverse 
video bar, it remains on the second menu line. If your menu 
cursor is a cross hair, it appears on the drawing surface. 
Section 4 describes menu cursors. 

The Layout Submenu contains three layout formats. 

Portrait ILandscapel Screen 

Figure 5-7. Layout Submenu 

PORTRAIT is the format of a vertical sheet of standard 
letter-size paper, 8 112-inches wide by ii-inches high. A 
rectangular outline on the drawing surface shows you the 
PORTRAIT layout boundaries. 

LANDSCAPE is the format of a sheet of horizontal paper, 
8 1I2-inches high by ii-inches wide. A rectangular outline 
on the drawing surface shows you the LANDSCAPE lay­
out boundaries. 

SCREEN format uses the entire drawing surface; the win­
dow frame is the layout boundary. When you PICK the 
CREATE function, DR Draw automatically places you in 
SCREEN layout. 
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LAYOUT 

PORTRAIT 

El 

LANDSCAPE 

SCREEN 

LAYOUT 

Figure 5-8 shows the relationship of layout to output. 

PRINTER or PLanER 
OUTPUT 

Figure 5-8. Layout to Output 

SCREEN 
OUTPUT 
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MOVE 

MOVE 

Purpose 

Prompts 

DR Draw User's Guide 

The MOVE function allows you to relocate the current 
element to another position on the drawing surface. 

When you PICK the MOVE function, DR Draw displays 
two prompts in the sequence below. 

PICK reference point 

PICK a reference point on or near the element's extent. 
Reference points are described under the COpy function. 

In many cases a corner of the extent is the easiest point to 
use. 

PICK new location, press DONE to finish 

Move the cursor to the reference point's new location any­
where on the drawing surface and PICK that point. DR 
Draw deletes the element from its current position and 
redraws it at the new location. 

If you are not satisfied with the element's location, you can 
PICK another point. Again, DR Draw deletes the element 
and redraws it in the new location. When you are satisfied 
with the location, press the DONE key to return to the Edit 
Menu. 
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OUTPUT 

Purpose 

Output Submenu 

Printer 

Printer/Plotter 

Screen lIScreen 2 

Camera 

OUTPUT 

The OUTPUT function sends your picture file to one of 
four output devices. 

When you PICK the OUTPUT function, the Output Sub­
menu appears on the second menu line. The Output Sub­
menu lists the five possible output devices in the order 
shown below. If your menu cursor is a reverse video bar, it 
appears on the second menu line. If your menu cursor is a 
cross hair, it appears on the drawing surface. Section 4 
describes menu cursors. 

Plotter I Screen 11Screen 21 Camera 

Figure 5-9. Output Submenu 

You can send your picture file to be printed on printer or 
plotter paper or on transparencies. If you specify a printer 
or plotter, DR Draw prints or plots a single copy of the 
picture file, then returns you to the Main Menu. 

You can send your picture file to a black and white screen 
or to a color screen if you have the necessary equipment 
and software. For more information, refer to the Supple­
ment. 

DR Draw reproduces your picture file on a display screen 
without the window frame, layout lines, grid points, or 
menu lines. 

To return to the Main Menu from screen output, press the 
DONE key. 

You can send your picture file to a camera output device to 
make prints or slides. DR Draw transmits the picture file to 
the camera device and then returns you to the Main Menu. 

For more information on camera output, consult the docu­
mentation that came with the output device. 
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OUTPUT 

Prompt 

Output Time 

Error Messages 

DR Draw User's Guide 

DR Draw displays one of two prompts after you PICK an 
output device. 

Picture filenaMe? 

Type the filename after the prompt. If the filename is valid, 
DR Draw sends the picture file to the output device you 
PICKed. 

CHART? (or type new naMe) 

In this case, you have been working on a picture file called 
CHART. PIX and have either just saved or abandoned the 
file. 

If you have saved the file, this prompt allows you to pro­
duce output by pressing the RETURN key. 

If you have abandoned the file, this prompt allows you to 
produce output from the existing version of the file by 
pressing the RETURN key. 

In either case, this prompt also allows you to type a differ­
ent filename and produce output from another picture file. 

DR Draw requires time to process a picture file for output. 
The amount of preparation time depends on the number 
and types of design elements in the file. Do not worry if the 
output does not appear immediately. 

You can receive one of two error messages when you PICK 
the OUTPUT function. One error message is 

Abandon actil.!e picture file? (YIN) 

You PICKed the OUTPUT function without saving your 
active picture file. DR Draw displays this message instead 
of the Output Submenu. 

If you respond Y (Yes), DR Draw abandons your active 
picture file and displays the Output Submenu. Section 4 
discusses abandoning an active picture file. 

If you respond N (No), you return to the Main Menu. 
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The other error message is 

CHART: not found, press DONE 

OUTPUT 

DR Draw cannot find the file you named (in this case, 
CHART). Press the DONE key to return to the Main 
Menu. 

Check to see that you included a correct drive identifier, if 
one is required. The drive identifier appears in the message 
only if you gave it in your response to the filename prompt. 

This message also appears when you do the following: 

1. create a new picture file called CHART, but do not 
save it 

2. PICK the OUTPUT function. DR Draw displays the 
"Abandon active picture file?" prompt. 

3. abandon the active picture file. DR Draw displays the 
prompt 

CHART? (or type new naMe) 

4. press the RETURN key 

DR Draw displays the error message because no file called 
CHART exists. 
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RECALL 

RECALL 

Purpose 

Prompt 

DR Draw User's Guide 

The RECALL function lets you retrieve a picture file that 
you saved. DR Draw opens an active picture file by 
copying the file stored on your diskette. The original re­
mains on the diskette unless you replace it with the SAVE 
function. 

PICKing the RECALL function is like the following: 

• going to the cabinet where you store your drawings 

• taking out a drawing 

• making a photocopy of the drawing 

• returning the original to the storage cabinet 

• putting the copy on your drawing table 

DR Draw displays one of two prompts when you PICK the 
RECALL function. One prompt is 

Picture filenaMe? 

Respond by typing the filename. For example, type 
CHART. You do not need to give the .PIX filetype; DR 
Draw searches only for files with that filetype. 

If the file is in your directory, you see the following mes­
sage: 

CHART: reading file 

DR Draw displays the picture file and automatically places 
you in the EDIT function. You can then begin work on the 
file. 

The other prompt is 

CHART? (or type new naMe) 

This prompt indicates that you have been working on a 
picture file called CHART. PIX and have either just saved 
or abandoned the file. 
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Reading Files 

Current Element 

Retained 
Attributes 

Error Messages 

RECALL 

If you have saved the file, this prompt allows you to recall 
it by pressing the RETURN key. 

If you have abandoned the file, this prompt allows you to 
recall the existing version of the file by pressing the RE­
TURN key. 

In either case, the prompt also allows you to type a differ­
ent filename and recall another picture file. 

If the file is in your directory, you see the message: 

CHART: reading file 

DR Draw displays the picture file and automatically places 
you in the ED IT function. You can then begin work on the 
file. 

The amount of time DR Draw needs to read your file will 
vary, depending on the number and types of design ele­
ments in the file. For example, circles take longer to read 
than bars. 

When you RECALL a file, the current element is always the 
first design element that you added when you began the 
file. 

The following attributes of the recalled picture file are re­
tained from the last time you worked on the file: 

• the location of the window on the drawing surface 

• the layout 
• the status of GRID and SNAP 

You can receive one of three error messages when you 
PI CK the RECALL function. One error message is 

CHART: not foundt press DONE 

You gave a filename (in this case, CHART) that is not on 
the diskette. If you give a drive identifier as part of the 
filename, DR Draw includes it in the message. 
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Press the DONE key to return to the Main Menu. To recall 
a picture file, PICK the RECALL function again and give 
another filename. 

This message also appears when you do the following: 

1. create a new picture file called CHART, but do not 
save it 

2. PICK the RECALL function. DR Draw displays the 
"Abandon active picture file?" prompt. 

3. abandon the active picture file. DR Draw displays the 
prompt 

CHART? (or type new naMe) 

4. press the RETURN key 

DR Draw displays the error message because no file called 
CHART exists. 

The second error message is 

Abandon active picture file? (YIN) 

You PICKed the RECALL function without saving your 
active picture file. DR Draw displays this error message 
instead of the prompt. 

If you respond Y (Yes), DR Draw abandons the active 
picture file and prompts 

Picture filenaMe? 

or 

CHART? (or type new naMe) 

Section 4 discusses abandoning an active picture file. 

If you respond N (No), DR Draw returns you to the Main 
Menu. To continue working on your active picture file, 
PICK the EDIT function. To save the active file, PICK the 
SAVE function. 
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The third error message is 

CHART: incorrect forMatt press DONE 

DR Draw displays this message in several situations. 

1. You gave a .PIX filetype to a file that was not created 
with DR Draw. DR Draw cannot read the file. You 
can avoid this situation by not combining picture files 
and other files on the same diskette. 

2. Your computer lost power when you were saving a 
file. You find the file in your directory the next time 
you start your computer, but the file is missing in­
formation that DR Draw needs in order to read it 
successfully. 

3. There is a problem with the diskette from which you 
are trying to recall the file. The diskette might need to 
be reformatted, in which case all files on the diskette 
are lost. However, you might be able to save some of 
the files if you copy the diskette before you reformat it. 
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REDRAW 

REDRAW 

Purpose 

DR Draw User's Guide 

The RED RAW function lets you 

• see your picture file in its current state 
• redraw the grid 

Several of the EDIT functions, especially DELETE and 
MOVE, can alter the appearance of design elements or the 
grid. 

For example, if you place a polygon on top of a circle, the 
polygon masks some or all of the circle. If you delete the 
polygon, you cannot see the masked part of the circle until 
you use the REDRAW function. 

Similarly, when the grid is on, moving an element deletes 
the grid points under the element's original position. Use 
the REDRAW function to restore the grid. 

When the REDRAW is complete, DR Draw returns you to 
the Edit Menu. 
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SAVE 

Purpose 

Created Files 

Recalled Files 

SAVE 

The SAVE function stores your active picture file on a 
diskette. When you save a file, you can 

• retain the file's original name 
• rename the file 

The descriptions of the CREATE and RECALL functions 
use the analogy of a storage cabinet where you keep your 
pictures. With the SAVE function the analogy takes one of 
two forms, depending on whether you created or recalled 
the file. 

When you create a file, you write the file's name on an 
empty folder in your storage cabinet. When you save a file 
under its original name, you go over to the cabinet and slip 
the picture into its folder. When you rename the file, you 
change the name on the folder before putting the picture 
inside. 

When you recall a file, the original stays in the folder in the 
storage cabinet. You work on a copy. 

Saving the file under its original name is like going to the 
folder, destroying the original, and replacing it with the 
new verSIOn. 

When you rename the file, you go to the cabinet and open 
up a new folder. The new version of the file, bearing the· 
new name, goes into the new folder. The old version re­
mains in the cabinet under its original name. 
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SAVE 

Prompt 

Error Message 

DR Draw User's Guide 

DR Draw displays the following prompt when you PICK 
the SA VE function. 

CHART? (or type new naMe) 

Press the RETURN key to save the file under its original 
name (in this example, CHART). To save the file under a 
new name, type the new name before you press the RE­
TURN key. 

DR Draw displays one of these messages while the file is 
being saved: 

CHART: s a v in It f i I e 

or 

NEWNAME: savinlt file 

You can receive one of two error messages when you PICK 
the SA VE function. 

No active picture filet press DONE 

You PICKed the SAVE function without having an active 
picture file. Press the DONE key to return to the Main 
Menu. 

CHART: already existst press DONE 

To rename the file, you gave the name of a file that is 
already on the diskette with a .PIX filetype. Press the 
DONE key to return to the Main Menu. 
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SCALE 

Purpose 

PICK a New Extent 

Changing 
Proportions 

Moving Elements 
with SCALE 

SCALE: Text 

Prompts 

SCALE 

The SCALE function lets you 

• enlarge or reduce stroke font text 

• enlarge, reduce, or change the proportions of elements 
other than text 

The SCALE function affects only the current element. 

You tell DR Draw how much to enlarge or reduce the 
current element by PICKing the opposite corners of a rec­
tangle that becomes the element's new extent. 

For all design elements but text, you can change the ele­
ment's proportions. For example, you can use SCALE to 
change a circle to an oval. . 

The new extent that you define can be anywhere inside the 
window frame. You can, for example, use SCALE to 
change a large circle in the upper left corner of the drawing 
surface to a small oval in the lower right corner. 

When you PICK the SCALE function to enlarge or reduce 
the size of stroke font characters, DR Draw displays three 
prompts in the sequence below. 

PICK corner of new extent 

Move the cursor to a point on the drawing surface and 
PICK the first corner of the new text extent. Unless you 
want to move the string at the same time, you can use the 
same point that you PICKed when you first entered the 
string. When you PICK the point, DR Draw extends verti­
cal and horizontal lines to show you two sides of the ex­
tent. 

PICK opposite corner of new extent 

Move the cursor diagonally and PICK the opposite corner 
of the new extent. 
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DR Draw extends a second set of vertical and horizontal 
lines. For the reasons given below, the intersection of the 
two lines might not be the point you PICKed. Figure 5-10 
illustrates how the two points can differ. 

Chief Executive Officer 

"'---- PICI( u;" point; ~ 
--DR Draw displO'jS these lines 

-- PICK this point 

~ 
p DR Draw displays these lines 

Chief Executive Officer 

-----------------------------------------------------~ DR Draw scales the string 
to this size C_hj_eJ ___ E_~~_~_uti'f_~ ___ Qffj_(_~[l 

Figure 5-10. Scaling Text 

You can change the size of stroke font characters but not 
their proportions. The two points you PICK define a rec­
tangle into which DR Draw tries to fit the text string. The 
lines that DR Draw displays indicate the best fit of the 
string in the rectangle you defined. 

The lines that DR Draw displays are an accurate indicator 
of the string's new size and shape. 

PICK Moves second cornert DONE finishes 

If you are not satisfied with the size of the extent, you can 
move the cursor and PICK a new second point. 

When you press the DONE key, DR Draw redraws the text 
string in the new size and returns you to the Edit Menu. 
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Error Message 

SCALE: Non-Text 
Elements 

SCALE 

You can receive the following error message when you 
PICK the SCALE function. 

Cannot SCALE Machine font. press DONE 

You tried to SCALE machine font characters. The size of 
machine font characters cannot be changed. 

The SCALE function lets you enlarge, reduce, or change 
the proportions of POLYGON, CIRCLE, ARC, LINES, or 
MARKERS design elements. 

When you PICK the SCALE function with a non-text cur­
rent element, DR Draw displays a submenu that gives you 
the option of retaining or changing the element's propor­
tions. 

Uniform Non-Uniform 

Figure 5-11. Scale Submenu 

UNIFORM retains the element's proportions. The result­
ing element is larger or smaller than the original, but it is 
the same shape. 

NON-UNIFORM changes the element's proportions. In 
addition to being larger or smaller than the original, the 
resulting element is a different shape. 

Figure 5-11 illustrates how SCALE works on text, mark­
ers, and a polygon. 
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SCALE 

original 

r--------- i.----: 

r ! : .: 
: : 
~ __ .. ___ ~ .. ___ .. __ J 

....... - .. --- -_ .. -- ........ -_ ... 

. 

Scaling Markers 

uniform 

ri5t~----Drawl 
~ ..... __ ............................. ____ ... ____ oJ 

.--------------------.-------, 

. j 

. . .......... ___ .......... __________ ............ __ ..... J 

DR Draw User's Guide 

non-uniform 

(text cannot be scaled 

non-uniformly) 

------------------ ....... - --- --- ---.., . , 

.' . , .. -- ---- .. -- -- --- ...... -- -- .................. .. 

Figure 5-12. SCALE Example 

Markers are a special case. Because they are machine font 
characters, you cannot scale single markers. You can, 
however, scale markers that you entered in a group. DR 
Draw changes the distance between the markers without 
changing the size of the markers. For more details on 
markers, refer to Section 6. 
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Prompts 

Error Message 

SCALE 

After you PICK the SCALE function, DR Draw displays 
three prompts in the sequence below. 

PICK corner of new extent 

Move the cursor to a point on the drawing surface and 
PICK one corner of the new extent. When you PICK the 
point, DR Draw extends vertical and horizontal lines to 
show you two sides of the extent. 

PICK opposite corner of new extent 

Move the cursor diagonally and PICK the opposite corner 
of the new extent. DR Draw again extends vertical and 
horizontal lines. The rectangle formed by the intersection 
of the four lines allows you to preview the new extent. 

PICK Moues second corner, DONE finishes 

If you are not satisfied with the size and/or shape of the 
extent, you can move the cursor and PICK a new second 
point. 

When you press the DONE key, DR Draw redraws the 
element to fit the new extent, then returns you to the Edit 
Menu. 

You can receive the following error message when you 
PI CK the SCALE function. 

Cannot SCALE this eleMent, press DONE 

DR Draw displays this error message in two situations. 

1. You tried to scale a single marker. Because a marker is 
a machine character, you cannot change its size. 

2. You tried to scale an element that is so small that DR 
Draw thinks it is a single point. This unusual situation 
can arise when you zoom out many times. 
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SELECT 

Purpose 

SELECT Rectangle 

DR Draw User's Guide 

The SELECT function lets you choose a new current ele­
ment from among the elements on the drawing surface. 

You select a current element by PICKing two points that 
mark the opposite corners of a rectangle. This rectangle 
must do one of the following: 

• enclose the entire design element 

• enclose one corner of the extent around the design ele-
ment 

• enclose one vertex of any design element except TEXT 

Figure 5-13 illustrates the three ways you can select a cur­
rent element. The second part of the figure, "enclose corner 
of extent," shows the extents around the two elements. 
The extent is not visible when you PICK the SELECT func­
tion, but is shown here for purposes of illustration. 

1. enclose entire element 2. enclose corner 
of extent 

3. enclose vertex 
(except text) 

Figure 5-13. Selecting a Current Element 
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Design Element 
Vertex 

open arc 

SELECT 

With the exception of the center of a circle or open arc, a 
vertex is any point you PICK while drawing a circle, arc, 
polygon, line, or group of markers. In addition, almost any 
point on the curved line of an arc or circle can be a vertex. 
The black circles in Figure 5-14 identify the vertices for 
each element. 

filled arc 

lines 

Figure 5-14. Vertices 

8 8 
markers 

8 

Figure 5-14 does not include a bar, because the vertices for 
the BAR design element are the same as the corners of the 
element's extent. 
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How SELECT Works 
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Following the prompts described below, PICK the opposite 
corners of the SELECT rectangle. DR Draw looks at the 
part of the picture file inside the rectangle and follows this 
series of steps: 

1. If the rectangle entirely enclos~s a design element, DR 
Draw selects· it as the current· element. 

If the rectangle encloses more than one design element, 
DR Draw selects the first'-drawn. 

If the rectangle does not entirely enclose a design ele­
ment, DR Draw passes to the next step. 

2. If the rectangle encloses the corner of the extent 
around a design element, DR Draw selects it as the 
current element. 

If the rectangle encloses the corner of more than one 
extent, DR Draw selects the first-drawn. 

If the rectangle does not enclose the corner of an ex­
tent, DR Draw passes to the next step. 

3. If the rectangle encloses a vertex of an arc, circle, line, 
or polygon, or if it encloses a single marker in a group 
of markers, DR Draw selects that element as the cur­
rent element. Figure 5-15 shows how you can enclose a 
vertex to select a design element in a shared extent, in 
this example an octagon inscribed in a square. 

If the rectangle encloses vertices of more than one ele­
ment or markers from more than one group of mark­
ers, DR Draw selects the first-drawn element. 

If the rectangle does not enclose a vertex or a marker, 
DR Draw retains the present current element as cur­
rent element. 
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SELECT rectangle 
surrounds this 
vertex of the 
polygon 

SELECT 

'-/'-/'-/'-/'-/'-/'-/'-/'-/'-/'-/'-/I~----- extent su rro u n d s 

I I 

M----------~ 

both design elements; 
the polygon is the 
current element 

Figure 5-15. Selecting One Element from a Shared Extent 
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Prompts 

Selecting TEXT 
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When you PICK the SELECT function from the Edit 
Menu, DR Draw displays three prompts in the sequence 
below. 

PICK corner of rectangle 

Move the cursor to one corner of the rectangle and PICK 
that point. DR Draw extends vertical and horizontal lines 
from the point. 

PICK opposite corner of rectangle 

Move the cursor to the rectangle's opposite corner and 
press the PICK key again. DR Draw projects vertical and 
horizontal lines from this point too. 

PICK Moves second corner, DONE finishes 

If you are not satisfied with the rectangle, you can move the 
cursor and PICK a different second corner. When you press 
the DONE key, DR Draw selects the new current element, 
draws an extent around it, and returns you to the Edit 
Menu. 

To select a text string, make the rectangle larger than you 
would for other design elements. The extent around a text 
string is somewhat larger than the characters it encloses. 
Figure 5-13 shows text in an extent. 
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STYLE 

Purpose 

Text 

The STYLE function changes the style attribute of your 
current element. Depending on the current element, the 
style attribute is one of the following: 

• type style 
• line style 
• fill pattern 
• marker style 

When you PICK the STYLE function from the Change 
Submenu, the Style Submenu replaces the Change Sub­
menu on the second line. If your menu cursor is a reverse 
video bar, it remains on the second menu line. If your menu 
cursor is a cross hair, it appears on the drawing surface. 
Section 4 describes menu cursors. 

The contents of the Style Submenu depend on whether the 
current element is text, a filled element, an open element or 
a line, or markers. 

For more information on styles, refer to Section 4 and to 
the descriptions of the design elements in Section 6. 

When the current element is text, DR Draw displays the 
following Style Submenu: 

I Machine I Simplex I Complex I Italic 

Figure 5-16. Style Submenu for TEXT 

The description of the TEXT design element in Section 6 
discusses the three default fonts and the font library. 
Appendix A explains how you can replace the default fonts 
for the Complex and Italic submenu selections with fonts 
from the library. 

The initial style for text is the machine font. 
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Filled Elements 

Open Elements and 
Lines 

Markers 
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When the current element is a filled arc, filled circle, poly­
gon, or bar, DR Draw displays a submenu of fill patterns. 
A small rectangle marks your position on the submenu. 
The type of computer you have determines the number of 
fill patterns in the submenu. 

Some printers or plotters might not be able to reproduce all 
the fill patterns you see on your computer. You can create a 
sample file by drawing a bar or polygon for each fill pattern 
your computer displays. Printing the file lets you see how 
the fill patterns appear in output. 

The initial style for filled elements is a solid fill. 

When the current element is an open arc, open circle, or a 
line, DR Draw displays a submenu of line styles. The type 
of computer you have determines the number of line styles 
in the submenu. 

Some printers or plotters might not be able to reproduce all 
the line styles you see on your computer . You can create a 
sample file by drawing a line for each style your computer 
displays. Printing the file lets you see how the line styles 
appear in output. 

The initial style for lines is a solid line. 

When the current element is a marker, DR Draw displays a 
submenu of five marker styles. 

Refer to the description of the MARKERS design element 
in Section 6 for more details on MARKERS. 

The initial style for MARKERS is an asterisk. 
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UNDELETE 

Purpose 

Design Element 
Order 

Error Message 

UNDELETE 

The UNDELETE function redraws the element that was 
most recently deleted from the picture file. 

DR Draw redraws the element, makes it the current ele­
ment, and returns you to the Edit Menu. 

UNDELETE works only on the last deleted element; pre­
viously deleted elements are lost. 

Because it redraws design elements, the UNDELETE func­
tion can change the order of design elements in a picture 
file. The undeleted element becomes the newest addition to 
the picture file. 

For example, if you select the arc (number 3) in Figure 5-4, 
delete, then undelete it, the redrawn arc is element 
number 6. 

For more on design element order, refer to the description 
of the DELETE function. 

You can receive the following error message when you 
PICK the UNDELETE function. 

No deleted eleMent, press DONE 

You PICKed UNDELETE without having deleted any­
thing. Press the DONE key to return to the Edit Menu. 
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VIEW 

Purpose 

Zoom In 

ZOOM IN 

Prompts 
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The VIEW function permits you to move the window over 
the drawing surface or to change design element order. 

When you PICK the VIEW function from the Change Sub­
menu, the View Submenu replaces the Change Submenu on 
the second line. If your menu cursor is a reverse video bar, 
it remains on the second menu line. If your menu cursor is 
a cross hair, it appears on the drawing surface. Section 4 
describes menu cursors. 

The View Submenu lists five functions. 

Zoom Fu" I Zoom Out I Pan I Put to Back I 
Figure 5-17. View Submenu 

ZOOM IN gives you a close-up view of a portion of what 
is currently in the window. To identify what you want to 
see in close-up, you PICK the opposite corners of a rectang­
le that DR Draw fits to the window frame. 

When you PICK the ZOOM IN function, DR Draw dis­
plays three prompts in the sequence below. 

PICK corner of window 

PICK the first corner of the rectangle. When you press the 
PICK key, horizontal and vertical lines extend from the 
cursor's position to the window frame. 

PICK opposite corner of window 

Move the cursor diagonally to the opposite corner of the 
rectangle and press the PICK key again. A second set of 
horizontal and vertical lines extends from the cursor's posi­
tion to the window frame. The rectangle formed by these 
lines gives you a preview of the area that will be enclosed 
by the window frame. 

PICK Moues second cornert DONE finishes 
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The Grid 

ZOOM FULL 

VIEW 

If you are not satisfied with the location of the second 
point, you can continue to move the cursor and press the 
PICK key. When you press the DONE key, DR Draw dis­
plays the close-up by fitting the rectangle you defined to the 
window frame. DR Draw then returns you to the Edit 
Menu. 

ZOOM IN decreases the density of the grid; individual 
points are farther apart. 

ZOOM FULL fits all the elements in your picture file to the 
current layout. 

If part of the picture file is outside the layout, ZOOM 
FULL proportionally reduces the elements and the space 
between them. 

If the whole picture file is within the layout, ZOOM FULL 
proportionally enlarges the elements and the space be­
tween them. 

Figure 5-16 illustrates three ways ZOOM FULL fits and 
centers the picture file in the layout. The broken-line out­
lines represent picture files, which can contain any com­
bination of design elements. The solid-line outlines are the 
layouts. 
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1. same proportions 

rOPI 

~qTI9~ 

2. horizont I a centering 

ZOOM FULL E centering Figure 5-18. 3. vertical 
xample 
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ZOOM OUT 

PAN 

Prompt 

PUT TO BACK 

VIEW 

In the first example, the picture file is larger than the layout 
but has the same proportions. ZOOM FULL reduces the 
picture file and fits it to the layout on all sides. 

In the second example, the proportions of the picture file 
and layout are different. ZOOM FULL reduces the picture 
file to fit the layout and centers the picture file horizontally. 

In the third example, the picture file is entirely within the 
layout but again has different proportions. ZOOM FULL 
enlarges the picture file and centers it vertically. 

ZOOM OUT reduces both the elements in the picture file 
and the space between them to two thirds their present 
size. The effect of ZOOM OUT is similar to what happens 
when you stand before a picture, then step back from it. 

ZOOM OUT also reduces the distance between grid points 
by the same amount. The grid becomes more dense. 

PAN allows you to move the picture file horizontally, verti­
cally, or diagonally in the window. The effect of PAN is 
similar to what happens if you move a rectangular frame 
over a large sheet of paper. 

When you PICK the PAN function, DR Draw displays 
intersecting lines that indicate the center of the window. 

DR Draw displays the following prompt when you PICK 
the PAN function. 

PICK new center of window 

Move the cursor to a point on the drawing surface that you 
want as the new center of the window. When you press the 
PICK key, DR Draw redraws the picture file with the new 
point in the center of the window. 

PUT TO BACK changes design element order by making 
the current element the first element in the picture file. 
When elements overlap or share the same extent, you can 
use PUT TO BACK to take the element on top and put it 
underneath. 
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1. 
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Figure 5-17 illustrates one use of PUT TO BACK. The 
following numbered sentences describe the three parts of 
the figure. 

1. Draw a bar, then a circle that partly overlaps the bar. 

2. Select the bar as the current element and change its fill 
pattern. The bar now overlaps the circle. 

3. Use PUT TO BACK to assign the bar to the first-drawn 
position. The circle again overlaps the bar. 

2. 3. 

Figure 5-19. PUT TO BACK Example 

The element that you PUT TO BACK remains the current 
element. 

End of Section 5 
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DESIGN ELEMENTS 

INTRODUCTION 

Add Submenu 

This section describes the seven DR Draw design elements 
in alphabetical order. 

• ARC 
• BAR 
• CIRCLE 
• LINES 
• MARKERS 
• POLYGON 
• TEXT 

When you PICK the ADD function from the Edit Menu, 
the Add Submenu appears on the second menu line. The 
Add Submenu lists DR Draw's seven design elements in the 
order shown below. If your menu cursor is a reverse video 
bar, it appears on the second menu line. If your menu 
cursor is a cross hair, it appears on the drawing surface. 
Section 4 describes menu cursors. 

Figure 6-1. Design Elements in the Add Submenu 
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Prompts 
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After you PICK a design element, DR Draw displays 
prompts that instruct you how to draw the element. 

Some design elements have two or more prompts, in which 
case you respond to one prompt before DR Draw displays 
the next. The design element descriptions list the prompts 
in the order you receive them and follow each prompt with 
a description of how you respond. 
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ARC 

Definition 

Prompts 

ARC 

An arc can be either part of the circumference of a circle (a 
curved line) or a filled pie section. 

When you PICK the ARC design element, DR Draw dis­
plays three prompts in the sequence below. 

PICK arc cente r 

PICK a point on the drawing surface to be the center of the 
arc. 

PICK arc radius/beginning of arc 

PICK a second point on the drawing surface. This point 
serves two purposes: 

1. It defines the radius of the arc. 

2. It defines the beginning of the arc. If you think of an 
arc as resembling the sweep of a windshield wiper, the 
beginning of the arc is like the wiper's position at the 
start of its sweep. 

PICK end of arc 

PICK a third point to define the end of the arc. To use the 
windshield wiper analogy again, the end of the arc is like 
the wiper's position at the end of its sweep. 

Because the arc's radius is established when you PICK the 
second point, the third point can be anywhere on a line 
from the center, as Figure 6-2 illustrates. 
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ARC 

" 

OPEN Arcs 

FILLED Arcs 

Changing Style 

, , , 
110° 

, , 
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" -orc radius/ 
/' beginning of arc 

(second point) 

Lore center (first poInt) 

Figure 6-2. Drawingan Arc 

After you PICK the last point, DR Draw shows you a 
submenu: 

Open Filled 

Figure 6-3. Arc Submenu 

An OPEN arc is a curved line that is part of the circumfer­
ence of a circle. The initial line style is a solid line. You can 
change style to one of several other line styles. 

A FILLED arc is a pie section. The initial style for fill is 
solid. You can change the fill to one of several other pat­
terns, including a hollow fill. 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 
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Drawing Arcs 

ARC 

The order in which you PICK the second and third points 
determines the appearance of the arc you draw. In both 
parts of Figure 6-4, the three points are the same, but the 
order of the second and third points is reversed. The arrow 
shows how DR Draw always starts with the second point 
and draws counterclockwise. If you PICK the sequence on 
the left, you get a pie slice. If you PICK the sequence on the 
right, you get the pie with the slice missing. 

2 

2 
.............................. 

3 

Figure 6-4. Drawing Arcs 

In addition, because the distance between points 1 and 2 is 
shorter on the right, the pie has a smaller radius than the 
slice. 
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BAR 

Definition 

Prompts 

Fill 

Changing Style 

Text in Bars 
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A bar is a filled rectangle. 

II11111111111111111111111 

When you PICK the BAR design element, DR Draw dis­
plays two prompts in the sequence below. 

PICK corner of bar 

PICK a point on the drawing surface. 

PICK opposite corner of bar 

Move the cursor diagonally to the opposite corner of the 
rectangle and press the PICK key again. 

As soon as you PICK the second corner point, DR Draw 
draws the bar and returns you to the Edit Menu. 

The initial style for bars is a solid fill. You can change the 
fill to one of several other patterns, including a hollow fill. 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 

You can insert text in a bar with hollow fill, but you must 
add the text after you draw the bar. Otherwise, the hollow 
fill pattern masks the text. You can avoid this situation by 
drawing the box with the LINES design element instead. 
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CIRCLE 

Definition 

Prompts 

Submenu 

OPEN Circle 

FILLED Circle 

Changing Style 

CIRCLE 

A circle can be either a circular outline or a filled disk. 

When you PICK the CIRCLE design element, DR Draw 
displays two prompts in the sequence below. 

PICK circle center 

PICK a point on the drawing surface to be the center of the 
circle. 

PICK circle radius 

Move the cursor any direction and PICK another point to 
establish the circle's radius. 

After you PICK the second point, DR Draw shows you a 
submenu: 

Open Filled 

Figure 6-5. Circle Submenu 

An OPEN circle is a circular outline. The initial line style is 
a solid line. You can change its style to one of several other 
line styles. 

The initial fill style is a solid fill. You can change the fill to 
one of several other patterns, including a hollow fill. 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 
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Your Screen 
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Because of the resolution and aspect ratio of some display 
monitors, circles can appear slightly oval on the drawing 
surface and in screen output. However, this effect is not 
present in printer or plotter output. 
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LINES 

Definition 

, , , , 
I , , , 

I 

Prompt 

Rubberband Line 

Style 

Changing Style 

I , , , 
I , 

LINES 

The LINES design element can be a single straight line or a 
series of connected line segments. 

~ , , 

I 
When you PICK the LINES design element, DR Draw dis­
plays a single prompt. 

PICK points, press DONE when finished 

PICK a starting point. Move the cursor to another point on 
the drawing surface, and PICK an endpoint. 

If you want a single straight line, press the DONE key to 
return to the Edit Menu. 

If you want a series of connected line segments, continue 
moving the cursor and pressing the PICK key. After you 
PICK the endpoint of the last line segment, press the 
DONE key to return to the Edit Menu. 

If your computer supports this feature, you can preview a 
line segment before you PICK its endpoint. DR Draw con­
nects the starting point and the cursor with a line that 
stretches like a rubber band as you move the cursor over 
the drawing surface. When you are satisfied with the posi­
tion of the line, PICK the endpoint. 

The initial style for lines is a solid line. You can change 
style to one of several other line styles. 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 
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Text in Boxes 

Drawing Over Lines 

LEFT 
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You can place text inside boxes drawn with lines, as in 
Figure 6-6. Unlike bars, polygons, filled circles, and filled 
arcs, shapes drawn with lines do not have a fill pattern that 
masks your text. 

You can draw over lines. For example, to draw the lines 
that connect the boxes in Figure 6-6, follow this sequence: 

• PICK a starting point on the lefthand box. 

• Move the cursor to the righthand box and PICK the 
endpoint of the first line segment. 

• Move the cursor back over the line to its midpoint and 
PICK again. 

• Move the cursor down to the lower box and PICK the 
final point. 

• Press the DONE key. 

RIGHT 

CENTER 
Figure 6-6. LINES Example 
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MARKERS 

Definition 

Prompt 

Groups of Markers 

Initial Style 

Changing Style 

Printing Markers 

Marker Size 

MARKERS 

A marker is a character that you can use to mark points, 
highlight, or accent design elements. Five marker styles are 
available. 

+ * o x 
When you PICK the MARKERS design element, DR Draw 
displays a single prompt. 

PICK pointst press DONE when finished 

To draw only one marker, move the cursor to the desired 
position on the drawing surface and press the PICK key. 
Then press the DONE key to return to the Edit Menu. 

To draw several markers, move the cursor and PICK each 
marker position before you press the DONE key to return 
to the Edit Menu. 

When you add several markers at once, DR Draw treats 
them as a single element. Functions like MOVE, COPY, 
and DELETE affect the entire group. In addition, you can­
not select individual markers from a group that was en­
tered together. 

The initial style for MARKERS is an asterisk. You can 
change style to one of several other marker styles. 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 

Markers are machine characters, not stroke font charac­
ters. The appearance of markers on printed output depends 
on your printer or plotter. For ready reference you can 
create and print a file with samples of each marker style. 

Because markers are machine characters, you cannot scale 
them individually. You can, however, scale the extent of a 
group of markers, as Figure 5-12 illustrates. 
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POLYGON 

Definition 

Prompt 

Rubberband Line 

Fill 

Changing Style 
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A polygon is a closed figure made up of straight line seg­
ments. Closed means that the beginning point of the first 
line segment is the same as the endpoint of the final line 
segment. The figures below are all polygons. 

When you PICK the POLYGON design element, DR Draw 
displays a single prompt. 

PICK pointst press DONE when finished 

PICK a point on the drawing surface. Complete the first 
line segment by moving the cursor and PICKing another 
point. Then move the cursor and PICK points to complete 
each subsequent line segment. Complete the polygon by 
joining the first and last points. Press the DONE key to 
return to the Edit Menu. 

If your computer supports this feature, you can preview 
each line segment before you PICK its endpoint. DR Draw 
connects the starting point and the cursor with a line that 
stretches like a rubber band as you move the cursor over 
the drawing surface. When you are satisfied with the posi­
tion of the line, PICK the endpoint. 

A polygon is a filled element. The initial style is a solid fill. 
You can change the fill to one of several other patterns, 
including a hollow fill. The fill pattern appears when you 
press the DONE key. 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 
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ZOOM IN and PAN 

POLYGON 

When you use ZOOM IN or PAN so that part of the 
polygon is outside the window frame, DR Draw eliminates 
the fill pattern. If you then use PAN, ZOOM FULL, or 
ZOOM OUT to bring the entire element back inside the 
window frame, DR Draw restores the fill pattern. 

For more information on these DR Draw functions, refer 
to Section 5. 
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TEXT 

Text Strings 

Prompt 
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A text string is a word, phrase, sentence, or any other 
group of characters and spaces you enter from the 
keyboard. 

You can use a variety of font styles from the DR Draw font 
library, which is described later in this section and in detail 
in Appendix A. Available characters include alphabetic 
and numeric characters, punctuation marks (except for the 
exclamation point), and the Greek alphabet. 

When you PICK the TEXT design element, DR Draw dis­
plays a single prompt. 

PICK startt tvpet RETURN; DONE finishes 

Move the cursor to the place where you want your text 
string to begin and press the PICK key. The text cursor 
replaces the graphics cursor on the drawing surface to indi­
cate where typed characters appear. 

Type the text string and press the RETURN key. 

The text cursor disappears, and the graphics cursor reap­
pears one text line below the previous line. You now have 
the following options: 

• PICK the cursor's present location as a point for enter­
ing text. 

• Move the cursor to a point on the same line as the 
previous string and PICK the start of a new string. 

• Move the cursor to another position on the drawing 
surface and PICK the start of a new string. 

• Press the DONE key to complete your text input and 
return to the Edit Menu. 

-------------------------- I!IDDIGITAL RESEARCH@ 

6-14 



DR Draw User's Guide 

RETURN Key and 
DONE Key 

Correcting Typing 
Errors 

Current Element 

Text String Length 

TEXT 

The text prompt makes a distinction between the RE­
TURN key and the DONE key. They are the same key on 
your keyboard, but they are functionally different. 

When you press the RETURN/DONE key at the end of a 
text string, it functions as a RETURN key. The graphics 
cursor moves down a line, and you can enter more text. 

When you press the RETURN/DONE key again, without 
PICKing a new point for entering text, it functions as a 
DONE key. DR Draw terminates your text input and re­
turns you to the Edit Menu. 

If you notice a typing error in your text string before you 
press the RETURN key, you can correct it by using the 
BACKSPACE key. Because the BACKSPACE key deletes 
characters, you have to retype the string from the point of 
the error. 

If you see the error after you press the RETURN key, use 
DELETE to erase the entire string and enter it again. 

When you enter multiple strings and press the DONE key 
to end your text input, the last string you entered becomes 
the current element. 

A single text string can be up to 79 characters long. 

However, you can enter text strings that are longer than 
the available line length on your display. For example, if 
you 

• have an 80-column display 

• start a text string anywhere after the second column 

• enter a 79-character text string 

the string extends past the right edge of the window frame. 
DR Draw handles this situation in the following manner: 

• The text cursor stops when it reaches the window 
frame. 
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• From then on, each character or space that you type 
appears in the position immediately preceding the cur­
sor, as Figure 6-7 illustrates. By displaying the charac­
ters in this way, DR Draw permits you to check the 
accuracy of your typing. 

• When you finish the string and press the RETURN key, 
the entire string becomes part of your active picture file. 
However, as Figure 6-7 also shows, you can only see 
the part of the string that is inside the window frame. 
You can use PAN, ZOOM OUT, or ZOOM FULL to 
bring the whole string back onto the drawing surface 
and make it fully visible. 

I 
This string is too 10._ 

characters appear here ______ --'1 
as you type 

This string is too Ion 
whot ~u see after you ~ 
press the RETURN key 

wh<Jt is on your diskette ~ 

--cursor 

--window frame 

This string is too long for your display. 

Figure 6-7. Text Too Long for the Display 
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Machine Fonts 

Stroke Fonts 

Text Style 

Font Library 

TEXT 

Machine font is the type style generated by your computer. 
The size and shape of machine font characters depend on 
the computer you are using. You cannot change the size of 
machine font text. 

Printers and plotters also have their own machine fonts 
distinct from the computer's. For that reason, you can ex­
pect printed output of machine font text to be different 
from what you see on your display monitor. 

The other fonts are called stroke fonts, which means that 
they are part of the software included with the DR Draw 
package. Using the SCALE function described in Section 5, 
you can change the size of stroke font text. 

Screen and printed output of stroke font text look the 
same. 

Regardless of the current style, text appears in machine 
font as you type. If your current style for text is one of the 
stroke fonts, DR Draw displays a bouncing extent to show 
how much space the string will occupy. When you press 
the DONE key, DR Draw rewrites the string in the current 
font style. 

DR Draw offers you a library of twelve stroke fonts. Table 
6-1 lists the menu names and the defaults for the stroke 
fonts. 

Table 6-1. Default Stroke Fonts 

Menu Name 

Simplex 
Complex 
Italic 

Default Font 

Simplex Roman 
Complex Roman 
Triplex Italic 

Appendix A contains samples of all the stroke fonts and 
tells you how you can replace default fonts with others 
from the library. 
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TEXT 

Changing Style 

Zooming on Text 

Recommended 
Procedure 

DR Draw User's Guide 

For more information on changing style, see the subsection 
on STYLE in Section 4 and the description of the STYLE 
function in Section 5. 

If you use ZOOM IN, ZOOM OUT, or ZOOM FULL on 
a picture file that combines machine font text and another 
element (for example, a polygon), the polygon changes in 
size, but the text does not. Zooming also changes their 
relative positions and can cause the polygon to overlap the 
text. 

When you use one of the ZOOM functions on a picture file 
that combines stroke font text and other elements, every­
thing enlarges or reduces equally. The relative positions 
remain the same. 

Section 5 describes the ZOOM functions. 

You might make a practice of immediately changing 
machine font text to one of the stroke fonts. If you do, your 
printed output matches what you see on your display 
screen, and you can use the ZOOM functions without 
affecting the relationship of the design elements in your 
picture file. 

End of Section 6 
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Appendix A 

FONT LIBRARY 

INTRODUCTION 

COpy YOUR 
DISKETTE 

PROGRAM DISKETTE 
AND DEFAULT 
FONTS 

DR Draw's font library allows you to select from 12 stroke 
fonts, including serif and sans-serif Roman fonts, as well as 
italic, script, Greek, and gothic fonts. 

The distribution diskettes that you receive with DR Draw 
include the font library diskette. Make a working copy of 
the library diskette before you use the font library. Store 
the original library diskette in a safe place in case you need 
to make copies in the future. 

The Supplement tells you how to copy a diskette. 

Your DR Draw work diskette contains three font files, 
named DRA W.BIN, FONTB.BIN, and FONTC.BIN. 
These files correspond in the following manner to the three 
stroke font selections in the Style Submenu for the TEXT 
design element: 

• If you PICK the Simplex submenu selection, DR Draw 
uses the font that is named DRAW.BIN. 

• If you PICK the Complex submenu selection, DR Draw 
uses the font that is named FONTB.BIN. 

• If you PICK the Italic submenu selection, DR Draw 
uses the font that is named FONTC.BIN. 
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When you receive DR Draw, the three font files on your 
program diskette contain DR Draw's three default fonts: 
Simplex Roman, Complex Roman, and Triplex Italic. You 
can retain the defaults, or you can replace Complex Ro­
man and Triplex Italic fonts with selections from the font 
library. 

Table A-l lists the font filenames on the program diskette, 
their corresponding submenu selections, and the default 
fonts. 

Table A-1. Font Files, Submenu Selections, and Defaults 

Submenu 
Filename 

DRAW.BIN 
FONTB.BIN 
FONTC.BIN 

Selection 

Simplex 
Complex 
Italic 

Default Font 

Simplex Roman 
Complex Roman 
Triplex Italic 

For information on changing fonts, refer to "Changing 
Fonts" in this appendix. 

-------------------------- i!IDDIGITAL RESEARCH® 

A-2 



DR Draw User's Guide Font Library Files 

FONT LIBRARY FILES The font library diskette contains twelve font files, includ­
ing files for the three default fonts. Table A-2lists the fonts 
and their corresponding filenames on the font library disk­
ette: 

Table A-2. Font Library Files 

Font Name Filename 

Simplex Roman SIMPROM 
Complex Roman COMROM 
Duplex Roman DUPROM 
Indexical Roman INDROM 

Triplex Italic TRIITA 
Indexical Italic INDITA 
Gothic Italic GOTITA 

Simplex Script SIMSCR 
Complex Script COMSCR 

Simplex Greek SIMGRE 
Complex Greek COMGRE 
Indexical Greek INDGRE 
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Figure A-I shows the word Draw in the four Roman fonts. 
Note that the size of the characters and the letter spacing 
differ from one font to the next. 

Draw 
Draw 

Draw 

Draw-
Figure A-1. Illustration of the Four Roman Fonts 

"Font Character Sets" in this appendix shows the full char­
acter set for each font. 
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CHANGING FONTS 

STYLE SUBMENU 
FOR TEXT 

Changing Fonts 

To replace default fonts with fonts from the library, you 
must use operating system commands. 

If you are using DR Draw, return to the Main Menu, and 
PICK the EXIT function. 

When you see the operating system prompt, you can use 
your operating system's file copying command to copy font 
files from the library diskette to your work diskette. In 
most cases you will place the work diskette in the A drive 
and the library diskette in the B drive. Then copy the font 
file you want from the library diskette, renaming it to 
FONTB.BIN or FONTC.BIN. 

When you copy the font files, remember to include the 
filetype for the file on the library diskette. Table A-2 does 
not list filetypes because they can vary. 

For detailed information on file copying, refer to your 
operating system manual. 

Replacing default fonts with fonts from the library does 
not change the Style Submenu for the TEXT design ele­
ment. The submenu still lists the stroke font styles as Sim­
plex, Complex, and Italic. 

The submenu selection Simplex always produces text in the 
font Simplex Roman. Do not try to change the font file 
called DRA W.BIN. 

The submenu selection Complex always uses the font 
file named FONTB.BIN. Although the default font for 
FONTB.BIN is Complex Roman, you can copy any font to 
the work diskette and rename it FONTB.BIN. 

The submenu selection Italic always uses the font file 
named FONTC.BIN. Although the default font for 
FONTC.BIN is Triplex Italic, you can copy any font to the 
work diskette and rename it FONTC.BIN. 
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FONTS AND 
PICTURE 
FILES 

DR Draw User's Guide 

When you recall a picture file, DR Draw remembers the 
Style Submenu selection you PICKed for each text string 
and uses the font currently in the corresponding font file on 
the program diskette. 

For example, suppose you enter three text strings: 

• "DR Draw," using the submenu selection Simplex 

• "Graphic Application," using the submenu selection 
Complex 

• "User's Guide," using the submenu selection Italic 

If FONTB.BIN and FONTC.BIN contain the default fonts, 
"DR Draw" appears in Simplex Roman, "Graphic Ap­
plication" appears in Complex Roman, and "User's 
Guide" appears in Triplex Italic. . 

After you save the picture file, you EXIT from DR Draw. 
Using operating system commands, you copy font files to 
the work diskette, renaming them as follows: 

• GOTIT A to FONTB.BIN 
• SIMSCR to FONTC.BIN 

When you recall the picture file, "DR Draw" still appears 
in Simplex Roman, but "Graphic Application" now 
appears in Gothic Italic and "User's Guide" in Simplex 
Script. 
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ERASING FONT FILES Do not under any circumstances erase any of the font files 
on your library diskette. 

RESTORING FONTS 
TO THE DEFAULTS 

FONT CHARACTER 
SETS 

If you erase FONTB.BIN or FONTC.BIN from the work 
diskette and then PICK either the Complex or Italic sub­
menu selection, DR Draw automatically uses Simplex Ro­
man. 

If you erase DRA W.BIN, you cannot start DR Draw. You 
see the message: 

No font filest press RETURN 

Press the RETURN key to return to the operating system 
prompt. 

If you change the font files in FONTB.BIN and 
FONTC.BIN, the changes are retained on your work 
diskette. If you want to restore the defaults, you can return 
to the operating system and copy the font files for Complex 
Roman and Triplex Italic from the font library diskette to 
FONTB.BIN and FONTC.BIN, respectively. 

Each of the following figures shows a full character set for 
one of the available fonts. These examples are scaled equal­
ly so you can compare the size of the characters in the 
fonts. 

Six fonts have numerals and basic punctuation marks. In 
these fonts, the keyboard pound sign (#) translates to a 
degree symbol, and the left and right angle brackets ( < 
and> ) translate to opening and closing single quotes. 

The remaining six fonts have no numerals or punctuation. 

Note also that the Greek alphabet has no letters corres­
ponding to the J and V keys. 
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Ao BbCcOd EeFfGg H h Ii 

J j KkLl M m N nOoPpOq Rr 

SsTtUuVvWwXxYyZz 

1234567890o $&*() 
- == + .. /? ' , I II , . , . . 

Figure A-2 Simplex Roman Character Set 

Aa BbCcDd EeFfGg H h Ii 

JjKkLI MmNnOoPpQq Rr 

SsTtUuVvWwXxYyZz 

1234567890o $&*() 
= = + . . /? ' , , " , . , . . 

Figure A-3. Duplex Roman Character Set 
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AaBbCcDdEeFfGgHhli 

JjKkLIMmNnOoPpQqRr 

SsTtUuVvWwXxYyZz 

1234567890o $&*() 
- == + . . /~ ( ~ , " , . , . . 

Figure A-4. Complex Roman Character Set 

AaB bCcDdE eFfG g Hhli 
JjKkLIMrnNnOoPpQqRr 
SsT t u u V V W w Xx Y yZ z 

1234567890° $&*() 
_==+99 I? ~ ~ y yy 

~ 9 ~ 9 a 

Figure A-S. Indexical Roman Character Set 
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AaBbCcDdEeFfGgHhli 

JJ-KkL lM rnN nO oPp Q q Rr 

SsTtUuVvWwXxYyZz 

1234567890 0 $&*() 
- = + .. /? ' , , , , , . , . . 

Figure A-6. Triplex Italic Character Set 

AaB bCcDdE eFfGgHhli 
J jKkL lMrnN nO oPp Q qRr 

SsTtUuVvWwXxYyZz 
Figure A-7. Indexical Italic Character Set 
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A~m~C~d2~h~XhJ& 

JfXUjX(Umnrv~rPp!2Cf~ 

b~t7b Vu-W ~X(D Ylft? 
Figure A-8. Simplex Script Character Set 

A e»fJ3 & r3 oJ) eLS 0g J<& ~lvJi 

:J jXk;fULrruK n(O ~fP ~CffR~ 

:J ~gtUu;7}~W WX'J)Y ~'f 

1234567890 o$&*() 
- == + .. /Q ' , / / / , . , . . 

Figure A-9. Complex Script Character Set 

Font Character Sets 
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Acx Bf3 H1]6c5 Ec:¢cp I )lXXI0 

KKAAM~NvOonTI8vpp 

LCJTTTv Ow-~'fr1J;Z( 
Figure A-tO. Simplex Greek Character Set 

AcxB (3H 7] ~oE G CPcp f)l Xx IL 
KKA\MMNvOOIT1T819Pp 

~(JTTYV OCJE~'l'1fZ( 
Figure A-l1. Complex Greek Character Set 
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AaBf3H 1} LlO E E<I>cp fyXXIL 
K~AAMMNvOorr~®vpp 

2:aTT'Y'v OwZ~w1/lZ~ 
Figure A-12. Indexical Greek Character Set 

8aflbarOb8r8f8gD~Xi 

11! B kG I rom On 0 0 Qp Q q 8r 

§5C)tauVUOJwxx~yaJ 
Figure A-13. Gothic Italic Character Set 

End of Appendix A 
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AppendixB 

Additional DR Draw Messages 

INTRODUCTION 

STARTING DR Draw 

This appendix describes error messages that you might see 
while starting or using DR Draw. 

When starting DR Draw, you might see one of the follow­
mg messages. 

No DRMSGBO.TXT, press RETURN 

If your system has an 80-column display monitor, you can­
not start DR Draw without a file called DRMSG80.TXT 
on your work diskette. 

If you see this message, the file DRMSG80.TXT is not on 
your work diskette. Use your operating system's file­
copying command to copy the file from the distribution 
diskette you received with your DR Draw package to the 
work diskette. 

No DRMSG40.TXT, press RETURN 

If your system has a 40-column display monitor, you can­
not start DR Draw without a file called DRMSG40.TXT 
on your work diskette. 

If you see this message, the file DRMSG40.TXT is not on 
your work diskette. Use your operating system's file­
copying command to copy the file from the distribution 
diskette you received with your DR Draw package to the 
work diskette. 
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DRAW, BIN not SIMPROM, nnn , press RETURN 

A font file other than SIMPROM.nnn has been copied and 
renamed to the file DRAW.BIN on the DR Draw work 
diskette. The font named DRA W.BIN must be Simplex 
Roman. The nnn in the above example represents a 
filetype. 

Press the RETURN key, and copy the file SIMPROM.nnn 
from the font library diskette. As you copy the file, rename 
it to DRA W.BIN. 

No ~raphics input, press RETURN 

You see this message if one of the following conditions 
exists. 

1. The GSX program has not been installed. GSX must 
be installed before you can start DR Draw. 

Some systems install GSX automatically when you 
start DR Draw. In other systems you must install GSX 
before you can start DR Draw. Refer to the Supple­
ment if you are not sure which type of system you 
have. 

2. In the ASSIGN.SYS file on your work diskette, the 
device driver for your display monitor is either missing 
or incorrectly specified. 

The file specification of the monitor driver in the 
ASSIGN.SYS file is preceded by a logical device num­
ber from 01 to 10. 

Ensure that the ASSIGN.SYS file on the work diskette 
meets the following requirements: 

a. A logical device number from 01 to 10 precedes 
the filename of the monitor device driver. 

b. The filename preceded by the logical device num­
ber from 01 to 10 corresponds to a monitor device 
driver file on the work diskette. 
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USING DR Draw 

Using DR Draw 

While using DR Draw, you might see one of the following 
messages. 

Cannot add More eleMentSt press DONE 

DR Draw has a limit of two hundred design elements per 
picture file. You see this message if you try to add more 
than two hundred elements. 

Not enou~h space on disKt press DONE 

When you are in a picture file and try to use the CREATE, 
RECALL, or SAVE function, this message appears if insuf­
ficient space exists on the diskette where the file will be 
stored. The storage space required varies, depending on the 
function you PICK. 

• CREATE: The diskette must have at least 12 Kilobytes 
of available space, in addition to the size of the file. The 
following two examples illustrate how this restriction 
applies to the CREATE function. 

1. If the diskette has 10 Kilobytes of space when you 
PICK the CREATE function, DR Draw displays 
the message and does not permit you to start the 
new file. You can either delete unwanted files from 
the diskette or use a diskette with sufficient space. 

2. If the diskette has 15 Kilobytes of available space, 
you can start the new file and add design elements 
that consume 3 Kilobytes of space before DR Draw 
displays the message and does not allow you to add 
more design elements. 

Save the file, then delete unwanted files from the 
diskette or copy the file to a diskette with sufficient 
space. 
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• RECALL: When you recall a file, DR Draw produces 
an active picture file by making a copy of the file on 
your diskette. Therefore, the minimum available space 
on the diskette must be 12 Kilobytes plus the size of file 
you are recalling. However, if you intend to add design 
elements to the file, the diskette must have space for the 
new design elements, in addition to the size of the file 
and the 12 Kilobyte minimum. 

If you cannot recall the file or if the diskette has insuf­
ficient space for additional design elements, return to 
the operating system. You can delete unwanted files 
from the diskette or copy the file to a diskette with 
sufficient space. 

• SAVE: When you SAVE a file to another drive, the 
diskette on that drive must have available space equal 
to 12 Kilobytes plus the size of the file you are saving. 

To see how much space remains on the diskette and to 
check the size of a picture file, use the appropriate operat­
ing system commands. For more information on the com­
mands, refer to your operating system manual. 

Bad drive identifiert press DONE 

DR Draw displays this error message when you use a drive 
identifier for a drive that does not exist on your system. 
This situation can arise when you PICK the CREATE, 
RECALL, SAVE, DIRECTORY, and OUTPUT functions. 

For example, if your system has only two drives, A and B, 
and you type 

J:CHART 

in response to the "Picture filename?" prompt, DR Draw 
displays the message. 

End of Appendix B 
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A 

Active picture file, 4-15 
ADD, 5-3 
Add Submenu, 5-3,6-1 
ARC, 2-46, 6-3 
Arc Submenu, 6-4 
arrow keys, 2-8, 4-8 
attributes, retained, 5-25 

B 

BACKSPACE key, 2-4,4-8, 6-15 
BAR, 2-42, 3-20, 6-6 

c 
CHANGE, 5-4 
change proportions, 

SCALE, 5-31 
Change Submenu, 5-1, 5-4 
CIRCLE, 2-36, 6-7 
Circle Submenu, 6-7 
COLOR, 2-44, 5-5 
Color Submenu, 5-5 
COPY, 2-12, 3-4, 5-6 
correcting typing errors, 6-15 
CREATE, 2-4, 2-35, 5-8 
cross hair, 2-7, 4-7 
current element, 4-9, 5-25 
current style, 4-12 

cursor, 4-7 

D 

change speed, 2-16,4-9 
graphics (cross hair), 

2-7,4-7 
menu, 4-7 
reverse video, 4-7 
text, 4-9, 6-14 

default font, 6-17 
DELETE, 2-11, 3-19, 5-10 
design elements, 6-1 

order, 5-10, 5-43 
DIRECTORY, 2-26, 5-12 
disk drive identifier, 4-16 
DONE, 1-4, 2-6 
DONE/RETURN key, 6-15 
drawing over lines, 6-1 ° 
drawing surface, 4-5 
DRMSG40.TXT, B-1 
DDMSG80.TXT, B-1 

E 

EDIT, 5-13 
Edit Menu, 4-3, 5-13 
error messages, 4-4, 5-2, B-1 

bad drive, B-4 
CREATE, 5-8 
DIRECTORY, 5-12 
EDIT, 5-13 
EXIT, 5-14 
general, B-3 
OUTPUT, 5-21 

I!ID DIGITAL RESEARCH@ ------------------------

Index-l 



RECALL, 5-24 
SAVE, 5-29 
SCALE, 5-31, 5-33 
starting, B-1 
UNDELETE, 5-43 

EXIT, 2-34, 2-48, 5-14 
extent, 2-11, 4-9 

bouncing, 3-6 
shared, 4-10, 5-39 

F 

filenames, 2-4, 4-14 
filetype, 4-14 
illegal characters, 4-14 
period, 4-14 
spaces in, 4-14 

filetype, 4-14 
FILLED design elements, 

4-12,5-42 
font library, 6-17, A-1 
fonts 

and picture files, A-6 
changing, A-5 
character sets, A-7 
default, 6-17, A-1 
library files, A-3 
machine, 6-17 
restoring, A-7 
stroke, 6-17 

functions, 5-1 

G 

graphics cursor, 2-7, 4-8 
keyboard, 4-8 
mouse, 4-8 
range of motion, 4-8 
speed and distance, 4-9 

GRID, 4-6, 5-15 
GRID OFF, 5-15 
GRID ON, 5-17 
Grid Submenu, 5-15, 5-17 

H 

hollow fill, 4-13 

I 

illegal characters, 4-14 
Initial Style, 4-11 

L 

LANDSCAPE layout, 5 -18 
layout, 5 -18 
LAYOUT, 2-27, 5-18 

default, 2-29 
LINES, 2-6, 2-22, 3-9, 6-9 

M 

machine font, 2-19 
machine fonts, 6-17 
Main Menu, 1-4,2-3,4-2 
MARKERS, 6-11 

groups of, 6-11 
printing, 6-11 
SCALE, 5-34 
size, 6-11 

menu cursor, 4-7 
wrapping, 4-8 

menus, 1-4,4-1 
mouse, 1-4,2-8,4-8 
MOVE, 2-14, 5-20 
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move elements, 
SCALE, 5-31 

N 

non-text elements, 
SCALE, 5-33 

NON-UNIFORM, 5-33 

o 
OPEN design element, 4-12, 5-42 
OUTPUT, 2-32, 5-21 
Output Submenu, 5-21 
Overlapping Elements, 5 -1 0 

p 

PAN, 3-2, 5-47, 6-13 
PICK, 1-3,2-3,2-4,2-6 
picture file diskette, 4-16 
plotting, 5-21 
POLYGON, 2-38,6-12 
PORTRAIT layout, 5-18 
print picture file, 2-32, 5-21 
prompts, 4-4, 5-2, 6-2 
PUT TO BACK, 3-39,5-47 

R 

RECALL, 2-26, 3-1, 3-17, 5-24 
REDRAW, 2-11, 5-28 
reference points, 5-6 
rename picture file, 2-31 
retained attributes, 5-25 
reverse video, 4-7 
rubberband line, 6-9, 6-12 

s 
SAVE, 2-25, 2-47, 3-17, 

3-42,5-29 
SCALE, 3-21, 5-31 
SCREEN layout, 5-18 
SELECT, 3-19, 5-36 
shared extents, 5-39 
SIZE 0.5X, 2-15, 5-16 
SIZE 2X, 5-15 
SNAP, 2-8, 4-6, 5-15 
SNAP OFF, 3-14, 5-16 
SNAP ON, 5-17 
SPACE BAR, 1-4, 2-3 
string, 6-14 
starting, 2-1 
STYLE, 4-11, 5-41 

attributes, 4-11, 5 -41 
BAR, 3-38 
CIRCLE, 2-36 
current, 4-12 
default POLYGON, 2-38 
FILLED, 4-12 
hollow fill, 4-13 
initial, 4-11 
LINES, 3-13 
OPEN,4-12 
POLYGON, 2-38 
TEXT, 2-19, 3-10 

Style Submenu, 5-41 
submenus, 4-4 
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T 

TAB key, 2-4, 4-8 
TEXT, 2-16,3-8,6-14,6-17 

correcting typing errors, 
6-15 

default fonts, 6-17 
SCALE, 5-31 
string length, 6-15 
ZOOM FULL, 6-18 
ZOOM IN, 6-18 
ZOOM OUT, 6-18 

text cursor, 4-9,6-14 

u 

UNDELETE, 2-11,5-43 
UNIFORM, 5-33 

v 

VIEW, 5-44 
View Submenu, 5-44 

w 
window, 4-6 
window frame, 4-6 

z 
ZOOM FULL, 2-30,3-16,5-16, 

5-45,6-18 
ZOOM IN, 3-29, 5-44,6-13,6-18 
ZOOM OUT, 3-21, 5-16, 

5-47,6-18 
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Dear OEM, 

l!!:!J 
DIGITAL 

RESEARCH® 

Instructions for Customizing DR Draw'· 

When you prepare DR Draw'" for distribution, you will do the 
following: 

• preconfigure a set of device drivers on the DR Draw program 
diskette 

• modify the text file for the GINSTALL program to reflect the 
device drivers you distribute 

• edit the README.DOC file on the DR Draw program diskette 

Because of these changes, you need to prepare a user's guide 
supplement to tell the user how to install DR Draw. To assist you 
in preparing a supplement, enclosed is a copy of the DR Draw Graphic 
A lication User's Guide Su lement for CP/M-a6 e and Concurrent 
CP M'" on the IBM~ Personal Com uter. You need to modify its 
contents to reflect your target computer and diskette configuration 
for DR Draw. The attached technical note identifies the sections 
and subsections of the supplement that might change. 

If you have questions about the technical note or about DR Draw in 
general, please contact your DRI Account Manager or the Technical 
Support Specialist in the DRI regional office nearest you. If they 
are unable to answer your questions, they will contact our Pacific 
Grove office for additional support. 

Thank you for your purchase of DR Draw. We look forward to working 
with you on future DRI software products. 

Sincerely, 
Digital Research Inc. 
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